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either of these documents before using the 
equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information.  Ensure that you clearly understand the meanings 
of the symbols BEFORE using the equipment.  Some or all of the following symbols may be used on all Anritsu 
equipment.  In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions.  Ensure that you clearly understand the meanings of the symbols 
and take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation.  The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution.  The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution.  The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note.  The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 
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1xEVDO IQproducerTM  
Operation Manual 
 
1 November 2004 (First Edition) 
23 October 2012 (Eighth Edition) 
 
Copyright © 2004-2012, ANRITSU CORPORATION. 
All rights reserved.  No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370103A 1xEVDO IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370103A 1xEVDO IQproducerTM is installed in the 

MG3710A, the applied directive and standards of this software conform to 
those of the MG3710A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370103A can be used with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370103A 1xEVDO IQproducerTM 
 
2. Applied Directive and Standards 
 When the MX370103A 1xEVDO  IQproducerTM is installed in the 

MG3710A, the applied directive and standards of this software conform to 
those of the MG3710A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370103A can be used with. 
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About This Manual 
■Associated Documents 

The operation manual configuration of the MX370103A 1xEVDO IQpro-
ducerTM is shown below.  

■If using MG3700A or MG3710A:  

Or 

 

MX370103A  
1xEVDO IQproducer™ Operation Manual  

 

MG3700A /MG3710A Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 
 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 
 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 
 

 

• MG3700A Vector Signal Generator Operation Manual (Mainframe) 
This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 
• MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 
This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator .  
 
• MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 
This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator . 
 
• 1xEVDO IQproducer™ Operation Manual (This document) 
This describes basic operations and functions of the 1xEVDO IQproduc-
erTM.  
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verview

 

This chapter provides an overview of the MX370103A 1xEVDO 
IQproducer 

 

1.1 Product overview .......................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Product overview 
MX370103A 1xEVDO IQproducer (hereinafter referred to as “this 
software”) is software used to generate waveform patterns conforming to 
the CDMA2000 1xEV-DO (1xEV-DO forward and 1xEV-DO reverse) 
specifications.  

 
This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of 1xEV-DO with various characteristics. This is made 
possible by the editing/customizing of parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal 
Generator ,or MG3710A Vector Signal Generator (collectively referred to 
as “mainframe”, or “this equipment”).  
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 

Software name MX370103A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*3 
256 M sample*4 
512 M sample*5 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, USB 
memory*2 

Installation of 
this software to 
this equipment 

N/A Possible  

 
*1: The ARB memory expansion 512M sample (optional) must be 

installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  

*5: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 
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■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, see Section 4.5 
“File Conversion on Convert Screen” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducerTM).  
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Preparation 

This chapter describes the operating environment for this software. 

 

2.1 Operating Environment ................................................. 2-2 
2.2 Installation/Uninstallation .............................................. 2-3 
2.3 Starting up and exiting the software ............................. 2-4 

2.3.1 Starting Software: When installed on PC ......... 2-4 
2.3.2 Starting Software: When installed on  

MG3710A ......................................................... 2-7 
2.3.3 Exiting Software ................................................ 2-9 
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2.1 Operating Environment 
The following environment is required for operating this software. 

(1) PC that meets the following conditions 
OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 
Refer to section 2 “Installation/Uninstallation” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 

■Installing/Uninstalling IQproducer™ license file 
For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

• MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

• MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 
The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on PC 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 
1. Click Start on the task bar, and point to All Programs. Next, point to 

Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

Figure 2.3.1-1  Program selection screen  
 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 
This Select instrument screen is used to select either MG3700A or 
MG3710A. This following explanation assumes that you have 
selected MG3700.  
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Figure 2.3.1-2  Select Instrument Screen 
 

Notes: 
• This software does not support MS269xA，MS2830A，and 

MG3740A. 

• To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 

3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.1-3  Common Platform Screen 
 

4. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  



 

Chapter 2  Preparation 

2-6 

 

Figure 2.3.1-4  System (Cellular) Selection Screen 
 

5. Click 1xEV-DO FWD or 1xEV-DO RVS to display the main screen. 
For details of the main screen, refer to Chapter 3 “Detailed 
Description of Functions”.  

Note: 
If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 
1. Press  on the MG3710A front panel to display the common 

platform screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 
 

2. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

Figure 2.3.2-2  System (Cellular) Selection Screen 
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3. Click 1xEV-DO FWD or 1xEV-DO RVS to display the main screen. 
For details of the main screen, refer to Chapter 3 “Detailed 
Description of Functions”.  

 
Note: 

When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box. 

 

Figure 2.3.2-3  Interface Settings Dialog Box 
 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default. 

• Row Socket Port Number 
Sets Row Socket port number. Set the same value as that for 
MG3710A.  

• Wait Time 
Sets the wait time between commands. 



 

2.3 Starting up and exiting the software 

2-9 

2 

Preparation 

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■When exiting only this software 
Perform the following steps in order to exit this software only, without 
closing the common platform screen or other IQproducer™ tools.  

• 1xEV-DO FWD IQproducer 
Click the Exit button.  

 

Figure 2.3.3-1  Exiting Software  
 

• 1xEV-DO RVS IQproducer  
1. Click the Exit button ( ) on the tool bar. 
2. Select Exit from the File menu. 
3. Click the  button on the upper right screen. 

 

 

Figure 2.3.3-2  Exiting Software 
 

The operation of the three screen buttons is explained below.  

 

Figure 2.3.3-3  Exit Confirmation Window 

 

• Yes Saves current parameters to file and stops this 
software. 

• No Stops this software without saving current 
parameters to file. 

• Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  
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■When exiting entire IQproducer™ application 
To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 

 

Figure 2.3.3-4  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software. 

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A functions are described as notes in each item. 

 

3.1 Detailed Description of 1xEV-DO Forward  
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3.1.1 Waveform pattern parameter setting screen .... 3-2 
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3.1 Detailed Description of 1xEV-DO Forward 

IQproducer™ Function 
3.1.1 Waveform pattern parameter setting screen 

3.1.1.1 Carrier Edit sheet 

Modulation parameters of a single carrier with carrier number 1 to 9, 
which is a component of a multicarrier, are set in the Carrier Edit sheet. 
This section describes the setting items and modulation parameters in 
the Carrier Edit sheet. Refer to Appendix B “Initial Value List” for the 
initial value of each setting item. 

 

Figure 3.1.1.1-1  Carrier Edit sheet 

 

(1) Save Parameter File 
Clicking this button saves the settings on the Carrier Edit sheet, 
RPC/RA CH Parameters screen, and Multicarrier Composition sheet 
in a parameter file with the extension “.prm”. 

(2) Recall Parameter File 
Clicking this button reads the parameter file for setting the items in 
the Carrier Edit sheet, RPC/RA CH Parameters screen, and 
Multicarrier Composition sheet. 

(3) Wave Data Length 
The number of frames for the waveform pattern to be generated can 
be specified up to 4 frames. Specify 3 frames when generating a 
multicarrier. 
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(4) Over Sampling 
The over sampling rate for the waveform pattern can be specified 
from 4, 8, and 16. 

(5) Default All 
Clicking this button restores the setting values of all the single 
carriers to the initial value. 

(6) Carrier 
A single carrier to be edited can be selected. The carrier number of 
the single carrier for which setting is carried out in the Carrier Edit 
sheet is displayed here. Set a value from 1 to 9. 

(7) Carrier Parameters Copy 
The settings of the single carrier that is currently being set can be 
copied to other single carriers. The copy destination (single carrier) 
can be specified here, from Carrier 1 to 9 or ALL Carrier. After 
setting the copy destination, click the [Execute] button on the right 
to start copying. 

All Carrier: The settings of the current single carrier (indicated 
by the carrier number in Carrier) are copied to all 
the single carriers. 

Carrier 1 to 9: The settings of the current single carrier (indicated 
by the carrier number in Carrier) are copied to the 
single carrier having the carrier number specified 
here. 

(8) Execute 
Clicking this button copies the settings of the current single carrier 
(indicated by the carrier number in Carrier) to the copy destination 
specified by Carrier Parameters Copy. The settings on the RPC/RA 
CH Parameters screen are also copied. 

(9) Data Rate 
The data rate and transmission slot for the single carrier to be 
generated can be specified. Set one of the following: 

1: 38.4kbps (16 slots) QPSK 

2: 76.8kbps (8 slots) QPSK 

3: 153.6kbps (4 slots) QPSK 

4: 307.2kbps (2 slots) QPSK 

5: 614.4kbps (1 slot) QPSK 

6: 307.2kbps (4 slots) QPSK 

7: 614.4kbps (2 slots) QPSK 

8: 1228.8kbps (1 slot) QPSK 

9: 921.6kbps (2 slots) 8-PSK 
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10: 1843.2kbps (1 slot) 8-PSK 

11: 1228.8kbps (2 slots) 16QAM 

12: 2457.6kbps (1 slot) 16QAM 

13: Idle Slot 

 When Data Rate is set to other than “13: Idle Slot”, Active/Idle for 
each slot of the target single carrier is automatically set according to 
the settings in 1st frame Active(1)/Idle(0) to 4th frame 
Active(1)/idle(0) (see (10) below). 
When Data Rate is set to “13: Idle Slot”, all the slots of the target 
single carrier are set to idle slots. 

(10) 1st frame Active(1)/Idle(0) to 4th frame Active(1)/Idle(0) 
Traffic channel active/idle can be set for each slot in binary. There 
are four frames from 1st frame to 4th frame, and each frame 
contains 16 slots. The MSB (leftmost bit) in each frame indicates the 
first slot in that frame, and each bit corresponds to the slot 
sequentially. When 0 is set, the corresponding slot is set to an idle 
slot, and is set to an active slot when 1 is set. When Data Rate is set 
to “13: Idle Slot”, all the slots of the target single carrier are set to 
idle slots. 

(11) TCH Data 
The payload data of the traffic channel can be set here. 

All ‘0’: The payload data is set to all 0. 

All ‘1’: The payload data is set to all 1. 

PN15: The payload data is set to non-continuous PN15. 
Note that PN15 is continuous within each frame. 

(12) Offset Index 
PN Offset Index of the single carrier to be generated can be specified 
here from 0 to 511. 

(13) TCH1 to THC4 
MAC Index, which is used for scrambling sequence of the traffic 
channel and for Walsh cover of the preamble, can be specified here 
by an integer number from 5 to 63. 

(14) Reg 1 to Reg 4 
The initial values of the linear feedback shift registers for PN15 
sequence generation when TCH Data is set to PN15 can be specified 
here by a hexadecimal number from 0000 to 7FFF. An offset can be 
added to the PN15 sequence of each TCH by changing these initial 
values. 
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(15) Carrier Default 
Clicking this button restores the settings of the current single 
carrier (indicated by the carrier number in Carrier) in the Carrier 
Parameters field to the initial values. 
The control in the Carrier Parameter frame becomes the set value 
for single carrier. 

(16) RPC/RA CH Parameters 
Clicking this button opens the RPC/RA CH Parameters screen, in 
which the parameters for RPC and RA channels can be set. 

 Refer to Section3.1.1.2 “RPC/RA CH Parameters screen.” 

(17) Carrier Calculate 
Clicking this button starts waveform pattern generation for 9 single 
carriers. The Execute and Result screen is displayed when this 
button is clicked. When “Complete” is displayed on the Execute and 
Result screen, the setting operations on the Carrier Edit sheet are 
completed. Click the [Multicarrier Composition] tab to open the 
Multicarrier Composition sheet, and proceed with multicarrier 
generation. 

(18) FFT 
Clicking this button opens the FFT graph display screen. In this 
screen, the FFT-processed spectrum of the generated waveform 
pattern is displayed in a graph. 

(19) CCDF 
Clicking this button opens the CCDF graph display screen. In this 
screen, the CCDF of the generated waveform pattern is displayed in 
a graph. 

(20) Transfer & Setting Wizard 
Clicking this button opens the Transfer & Setting Wizard screen. In 
this screen, a series of operations including connection between a PC 
and the MG3700A/MG3710A, waveform pattern transfer to the 
MG3700A/MG3710A internal hard disk, waveform pattern loading 
from the hard disk to the waveform memory and output waveform 
pattern selection are operated. 

(21) Exit 
Clicking this button exit this software. 
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3.1.1.2 RPC/RA CH Parameters screen 

This section describes the modulation parameters that can be set by 
controlling the items in the RPC/RA CH Parameters screen. To open the 
RPC/RA CH Parameters screen, click the [RPC/RA CH Parameters] 
button on the Carrier Edit sheet while the carrier number of the single 
carrier to be set is displayed in Carrier. Refer to Appendix B “Initial 
Value List” for the initial value of each setting item. 

 

Figure 3.1.1.2-1  RPC/RA CH Parameters screen 

 

(1) Frame 
A frame for which RPC and RA channels should be edited can be 
selected. The number of the frame for which setting is carried out in 
the RPC/RA CH Parameters screen is displayed here. 

(2) Slot 
A slot for which RPC and RA channels should be edited can be 
selected. The number of the slot for which setting is carried out in 
the RPC/RA CH Parameters screen is displayed here. 
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(3) RPC/RA Parameters Copy 
The RPC/RA channel parameter settings of the current slot can be 
copied to other slots. The copy destination slot can be specified here, 
from Slot 1 to 16, ALL Slot, or All Frame. 

All Frame: When the [Execute] button is clicked, the RPC/RA 
channel parameter settings of the current slot 
(indicated by the frame number in Frame and the 
slot number in Slot) are copied to all the slots 
within the single carrier. 

All Slot: When the [Execute] button is clicked, the RPC/RA 
channel parameter settings of the current slot 
(indicated by the frame number in Frame and the 
slot number in Slot) are copied to all the slots 
within the frame. No data is copied to other frames.  

Slots 1 to 16: When the [Execute] button is clicked, the RPC/RA 
channel parameter settings of the current slot 
(indicated by the frame number in Frame and the 
slot number in Slot) are copied to the slot having 
the slot number specified here. No data is copied to 
other frames. 

(4) Execute 
Clicking this button copies the RPC/RA channel settings of the 
current slot (indicated by the frame number in Frame and the slot 
number in Slot) to the copy destination specified by RPC/RA 
Parameters Copy. 

(5) RA Bit 
The RA bit of the RA channel can be set to 0 or 1. 

(6) CH Power 
The channel gain (value relative to the pilot channel) of the MAC 
channel can be set to a value from 40 to +40 dB. 

(7) RPC Bit 
The RPC bit of the RPC channel can be set to 0 or 1. 

(8) ON/OFF 
Each MAC channel can be set to ON or OFF. 

(9) RPC/RA Bit (Group Edit) 
All the RPC bits in the current slot can be set to 0 or 1. 

All ‘0’: All the RPC bits in the current slot are set to 0. 

All ‘1’: All the RPC bits in the current slot are set to 1. 
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(10) Channel Power (Group Edit) 
The channel gains (value relative to pilot channel) of all the MAC 
channels in the current slot can be set at once. Enter a channel gain 
value in the Value text box and then click the [Execute] button. 

(11) ON/OFF (Group Edit) 
All the MAC channels in the current slot can be set to ON/OFF at 
once. 

All ‘off ’: All the MAC channels in the current slot are set to OFF. 

All ‘on’: All the MAC channels in the current slot are set to ON. 

(12) Default 
Clicking this button restores the current slot to the initial state. 

(13) Default All 
Clicking this button restores the RPC/RA CH Parameters settings of 
the current single carrier to the initial values. 

(14) Normalize 
When this button is clicked, the channel gains of the RA and RCH 
channels of the current slot are collectively set based on the ratio 
indicated by fractions. Specify the ratio in the text boxes on the left 
of this button. The numerator of the RA channel ratio can be set 
from 1 to “denominator  1”, while the denominator can be set from 
2 to 99. 

 Refer to Section 3.1.1.5 “Normalize function for RRC/RA channels.” 
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3.1.1.3 Multicarrier Composition sheet 

In the Multicarrier Composition sheet, a multicarrier (or single carrier) 
waveform pattern can be generated from the single carrier waveform 
patterns generated on the Multicarrier Composition sheet. This section 
describes the setting items in the Multicarrier Composition sheet, as well 
as the correspondence with the multicarrier parameters and waveform 
pattern information file. Refer to Appendix B “Initial Value List” for the 
initial value of each setting item. 

 

Figure 3.1.1.3-1  Multicarrier Composition sheet (When running on PC) 

 

 

Figure 3.1.1.3-2  Multicarrier Composition sheet (When running on 

MG3710A) 
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(1) Spacing 
The frequency spacing between the carriers that have adjacent 
carrier numbers can be set from 1.20 MHz, 1.23 MHz, 1.25 MHz or 
1.35 MHz. The frequency spacing specified here is applied to all 
carriers. 

(2) Carrier Select 
 Whether to use the single carrier generated in the Carrier Edit 
 sheet for multicarrier generation can be set by specifying ON (use) 
 or OFF (not use). When only one single carrier is set to ON and the 
 others are set to OFF, a single carrier is generated, not multicarrier. 
 A single carrier with smaller carrier number is located lower on an 
 actual frequency axis, and a single carrier with greater carrier 
 number is located upper. The center frequency is centered between 
 the single carrier that is set to ON and has the greatest carrier 
 number and the single carrier that is set to ON and has the 
 smallest carrier number. The position of the center frequency in the
  multicarrier is indicated by “CF” on the screen that is displayed 
 when the [Composition Execute] button is clicked. 

(3) Target RMS Range 
The setting range of RMS can be set here. “RMS” indicates the RMS 
value of the waveform pattern in this event. “Max” indicates the 
maximum RMS value and “Min” indicates the minimum RMS value 
for waveform pattern RMS adjustment. RMS Adjustment Value 
must be set within this range (between “Max” and “Min”). 

(4) RMS Adjustment Value 
The RMS value of the multicarrier (or single carrier) waveform 
pattern can be set within the range between Max and Min set by 
Target RMS Range. Generally, the greater the waveform pattern 
RMS value becomes, the more output modulated signal is distorted, 
but the floor noise is reduced. The smaller the waveform pattern 
RMS value becomes, on the other hand, the less output modulated 
signal is distorted, but the floor noise is increased. 

(5) RMS Adjust 
This button is enabled when the value in RMS Adjustment Value 
has been changed once or more by executing Composition Execute 
after starting up this software. 
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Clicking this button converts the waveform pattern generated by 
clicking the [Composition Execute] to a waveform pattern that has 
an RMS value close to the value set in RMS Adjustment Value. The 
RMS value of the waveform pattern generated by executing 
Composition Execute is 1157. Execute RMS Adjust if the RMS value 
needs to be changed from 1157. Note that the RF output level 
accuracy of the MG3700A/MG3710A is not guaranteed if the 
waveform pattern RMS value is out of the range between 1157 and 
1634. Refer to the MG3700A Vector Signal Generator Operation 
Manual (Mainframe) or the MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator Operation Manual (Mainframe) 
for details of the RF output level accuracy. 

(6) Pattern Name 
 The pattern file name can be set within twenty 1-byte characters. 
 Alphanumeric and the following symbols can be used for a file 
 name: 
 ! % & ( ) + = ` { } _ - ^ @ [ ] 
 The extension “.wvi” (for waveform pattern information file) or 
 “.wvd” (for waveform pattern data file) is affixed to the pattern file 
 name specified here. 

(7) Composition Execute 
Clicking this button generates a waveform pattern. Two waveform 
pattern files are generated for one waveform pattern: waveform 
pattern information file (“.wvi”) and waveform pattern data file 
(“.wvd”). The RMS value of the generated waveform pattern is 
initially set to 1157. When changing this value, enter an RMS value 
to the RMS Adjustment Value text box in the Data Adjustment field, 
and then click the [RMS Adjust] button. 

(8) Calculation & Load  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform pattern 
is loaded into the MG3710A waveform memory.  

(9) Calculation & Play  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform pattern 
is loaded and selected at the MG3710A waveform memory.  
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3.1.1.4 Execution and Result screen 

When the [Carrier Calculate] button on the carrier Edit sheet or the 
[Composition Execute] button on the Multicarrier Composition sheet is 
clicked, waveform pattern calculation is started and the Execution and 
Result screen is displayed. This screen displays the waveform pattern 
calculation status and results, and these displayed contents are recorded 
to the log.dat file saved in the folder where the currently-executed 
IQproducer_1xEVDO.exe file is stored. Clicking the [Cancel] button 
during calculation interrupts the calculation. The calculation is 
completed when “Complete” is displayed on the screen. Click the [OK] 
button to close the Execution and Result screen. 

 

Figure 3.1.1.4-1  Execution and Result screen 

 

3.1.1.5 Normalize function for RPC/RA channels 

When the [Normalize] button on the RPC/RA CH Parameters screen is 
clicked, the channel gains of the RA and RPC channels of the slot 
currently set are collectively set based on the specified ratio. When the 
channel gain of the RA channel is set by a fraction as shown in Figure 
3.1.1.5-1 below, the channel gain of the RCH channel is automatically set 
to the value obtained by dividing the 1-RACH ratio by the number of 
RPC channels that are set to ON. Click the [Normalize] button to set the 
channel gains of the RPC and RA channels to the specified values. 

 RACH ratio RPCCH ratio 

 

Figure 3.1.1.5-1  Setting Normalizing 
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3.1.2 Waveform pattern generation procedure 
This section provides a general procedure for generating a 1xEV-DO 
forward type waveform pattern using this software. 

<Procedure> 

1. Start up this software. The Carrier Edit sheet is displayed. 

2. The parameters when this software is started up are those saved 
last time, except for the case when starting up this software for the 
first time. 
When reading a parameter file, click the [Recall Parameter File] 
button and select a parameter file for setting the parameters. To 
restore the parameters to the initial settings, click the [Default All] 
button. 

3. Set the parameters of each single carrier, which is a component of a 
multicarrier. 
If it is not necessary to set the parameters of the single carrier, 
proceed with Step 4. Setting is not required for single carriers that 
are not to be multiplexed to a multicarrier. 
When changing the MAC channel parameters, click the [RPC/RA CH 

Parameters] button while the carrier number of the target single 
carrier is displayed in Carrier on the Carrier Edit sheet. Then set 
the MAC Channel parameters on the RPC/RA CH Parameters 
screen. After setting the MAC Channel parameters, click the [OK] 
button to display the Carrier Edit sheet. 

4. Click the [Carrier Calculate] button to generate a single carrier 
waveform pattern data as an intermediate file. When “Complete” is 
displayed on the Execute and Result screen, click the [OK] button to 
close the Execute and Result screen. 

5. Click the [Multicarrier Composition] tab to open the Multicarrier 
Composition sheet. 

6. Select ON/OFF for Carrier 1 through Carrier 9 in the Carrier Select 
field, and enter a waveform pattern file name in the Pattern Name 
text box. 



 

Chapter 3  Detailed Description of Functions 

3-14 

7. Click the [Composition Execute] button. A multicarrier waveform 
pattern is generated based on the waveform pattern data of the 
single carriers generated in the Carrier Edit sheet. The waveform 
pattern files are generated in the Data folder, which is in the folder 
that stores the 1xEVDO_FWD.exe file. The waveform pattern 
information file name is “Name specified in Pattern Name + .wvi”, 
and the waveform pattern data file name is “Name specified in 
Pattern Name + .wvd”. 

Skip Step 8 when not changing the waveform pattern RMS value. 

8. Enter the RMS value of the multicarrier waveform pattern in RMS 
Adjustment Value, and click the [RMS Adjust] button. The waveform 
pattern files are generated in the Data folder, which is in the folder 
that stores the IQproducer_1xEVDO.exe file. The waveform pattern 
files are named in the same manner as described in Step 7 above. 

9. When generating another waveform pattern, repeat the procedure 
from Step 2.  
When setting single carrier ON/OFF for multicarrier generation or 
changing the waveform pattern file name in Pattern Name, repeat 
the procedure from Step 6. In this event, the single carrier waveform 
pattern data generated in Step 4 is used as is. 
When changing the RMS value, perform Step 8. 
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3.1.3 Saving/reading parameters 
With this software, all the set parameters can be saved in a parameter 
file (extension: .prm), and the settings at the time when saving the 
parameter file can be restored anytime as required by reading this 
parameter file. 

3.1.3.1 Saving parameter file 

When running on PC 

1. Click the [Save Parameter File] button in Carrier Edit sheet to 
display the parameter file saving screen. 

 

Figure 3.1.3.1-1  Parameter file saving screen 

 

2. Enter a file name in the [File name] text box and click the [Save] 
button to save the parameter file. 
When the save destination is not changed in the [Save in] box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\1xEVDO_FWD\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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When running on MG3710A 

1. Click the [Save Parameter File] button in [File] menu or click the 

  button to display the parameter file saving screen.  

 

Figure 3.1.3.1-2  Parameter File Saving Screen (MG3710A) 

 

2. Select the folder to store the file in the [Directories] field, and then 
enter the name of the file using the [File Name] box. Click [OK] to 
save the parameter file. To initialize the setting in the [Directories] 

field, click the [Default Root] button. 

 

3.1.3.2 Reading parameter file 

When running on PC 

1. Click the [Recall Parameter File] button in Carrier Edit sheet to 
display the parameter file saving screen.  

 

Figure 3.1.3.2-1  Parameter file reading screen 
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2. Select a parameter file to be read from the file list, and then click 
the [Open] button to read the selected parameter file. 
 

When running on MG3710A 

1. Select [Recall Parameter File] from the [File] menu or click the 
 tool button to display the parameter file reading screen.  

 

Figure 3.1.3-2  Parameter File Reading Screen (MG3710A) 

 

2. Select the directory where the files to be loaded is stored in the 
[Directories] field. Click the desired file from the [File List], and 
click [OK]. To initialize the setting in the [Directories] field, click the 
[Default Root] button. 
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3.1.4 Displaying graph 
The generated waveform pattern can be displayed in a CCDF or FFT 
graph by using this software. 

Displaying CCDF graph 

1. Generate a multicarrier waveform pattern by executing 
“Composition Execute.” 

2. Click the [CCDF] button. The CCDF Graph Monitor screen shown in 
Figure 3.1.4-1 is displayed with the trace of the generated waveform 
pattern. 

 

Figure 3.1.4-1  CCDF Graph Monitor screen 

 

When a waveform pattern is generated by changing parameters and 
executing “Composition Execute” while other traces are displayed in the 
CCDF Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods: 

 Displaying the new trace in the same screen with the previous traces 

 Deleting the previous traces to display the new trace 
 

Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When displaying a CCDF graph while an FFT graph is 
displayed, execute the CCDF graph generation after FFT graph 
generation is completed. 



 

3.1 Detailed Description of 1xEV-DO Forward IQproducer™ Function 

3-19 

3 

D
etailed D

escription
 of F

u
n

ction
s 

 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF Graph 
Monitor screen. 

2. Click the [CCDF] button. The trace of the waveform pattern newly 
generated is additionally displayed in the CCDF Graph Monitor 
screen. 
Up to eight traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF 
Graph Monitor screen. 

2. Click the [CCDF] button. The confirmation message shown in Figure 
3.1.4-2 below appears: 

 

Figure 3.1.4-2  Confirmation message 

 

 Click the [Yes] button. The previous traces are deleted from the 
CCDF Graph Monitor screen, and the trace of the waveform pattern 
newly generated is displayed. 
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Displaying FFT graph 

1. Generate a multicarrier waveform pattern by executing 
“Composition Execute.” 

2. Click the [FFT] button. The FFT Graph Monitor screen shown in 
Figure 3.1.4-3 is displayed with the trace of the generated waveform 
pattern. 

 

Figure 3.1.4-3  FFT Graph Monitor screen 

 

When a waveform pattern is generated by changing parameters and 
executing “Composition Execute” while other traces are displayed in the 
FFT Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods: 

 Displaying the new trace in the same screen with the previous traces 

 Deleting the previous traces to display the new trace 
 

Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When displaying an FFT graph while a CCDF graph is 
displayed, execute the FFT graph generation after CCDF graph 
generation is completed. 
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 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Click the [FFT] button. The trace of the waveform pattern newly 
generated is additionally displayed in the FFT Graph Monitor 
screen. 
Up to four traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Click the [FFT] button. The confirmation message shown in Figure 
3.1.4-4 below appears: 

 

Figure 3.1.4-4  Confirmation message 

 

 Click the [Yes] button. The previous traces are deleted from the FFT 
Graph Monitor screen, and the trace of the waveform pattern newly 
generated is displayed. 
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3.1.5 Detailed description of modulation parameter 

3.1.5.1 Single carrier 

This section describes the single carrier, which is a component of the 
multicarrier. 

Active Slot 

A waveform pattern of a single carrier for which Data Rate on the 
Carrier Edit sheet is set to other than “13: Idle Slot” is generated by 
time-division multiplexing the traffic channel data and MAC Channel, 
Preamble, and Pilot Channel according to 3GPP2 C.S0024. 
The traffic channel data consists of a PN15 sequence of the length 
corresponding to Wave Data Length and all-0 or all-1 payload data for 
which channel coding and IQ mapping have been executed. 

On a traffic channel that requires two or more transmission slots, traffic 
channel data is transmitted in every four transmission slots and traffic 
channel data of other packets are transmitted in the transmission slots 
between them, so that coded data of four packets are transmitted 
consecutively. The initial values of the MAC Indexes and the linear 
feedback shift register for PN15 sequence generation can be set 
separately by using the this software. 
Active/idle can be set for each slot in the single carrier by setting binary 
numbers to 1st frame Active(1)/Idle(0) to 4th frame Active(1)/Idle(0), 
unless Data Rate is not set to “13: Idle Slot” for that single carrier. In this 
event, however, note that the data in a slot that is set as an idle slot is 
not transmitted, since the data field in an idle slot is a non-transmission 
field. The data in an active slot is transmitted. 

The MAC channel to be multiplexed, values of RPC bit and RA bit, and 
channel gain can be set for each slot in a frame. It is also possible to set 
PN Offset Index. 
Figure 3.1.5.1-1 shows the forward packet format before coding and 
Figure 3.1.5.1-2 shows the block diagram of a 1xEV-DO forward active 
slot. 
Table 3.1.5.1-1 lists the active traffic channel parameters. 
Figure 3.1.5.1-3 shows an image of single carrier waveform pattern 
repetition and Figure 3.1.5.1-4 shows the 1xEV-DO forward active slot 
format after time-division multiplexing (TDM). 

FCS
16

Bits

TAIL
6

Bits

PN15fix*, All 0 or All 1
1002, 2026, 3050, or 4074

Bits

1024, 2048, 3072, or 4096 Bits

 

Figure 3.1.5.1-1  Forward packet format before coding 
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Figure 3.1.5.1-2  Block diagram of 1xEV-DO forward active slot 

 

Table 3.1.5.1-1  List of active traffic channel parameters 

No. 1xEV-DO Modulation Signal 
Data Rate 

(kbps) 
Transmission 

Slots 
Packet

(Bit) 
Preamble 

(Chip) 
Modulation 

Type 

1 38.4 kbps (16slots) QPSK 38.4 16 1024 1024 QPSK 
2 76.8 kbps (8slots) QPSK 76.8 8 1024 512 QPSK 
3 153.6 kbps (4slots) QPSK 153.6 4 1024 256 QPSK 
4 307.2 kbps (2slots) QPSK 307.2 2 1024 128 QPSK 
5 614.4 kbps (1slot) QPSK 614.4 1 1024 64 QPSK 
6 307.2 kbps (4slots) QPSK 307.2 4 2048 128 QPSK 
7 614.4 kbps (2slots) QPSK 614.4 2 2048 64 QPSK 
8 1228.8 kbps (1slot) QPSK 1228.8 1 2048 64 QPSK 
9 921.6 kbps (2slots) 8-PSK 921.6 2 3072 64 8-PSK 
10 1843.2 kbps (1slot) 8-PSK 1843.2 1 3072 64 8-PSK 
11 1228.8 kbps (2slots) 16QAM 1228.8 2 4096 64 16QAM 
12 2457.6 kbps (1slot) 16QAM 2457.6 1 4096 64 16QAM 
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Slot c in Frame b, 
Carrier a (1.67 ms) 

Frame b of Carrier a (26.67 ms) 

  

Pilot channel

MAC channel in Slot c, 
Frame b, Carrier a 

Traffic channel in Slot c, Frame b,
Carrier a 
Non-transmission for idle slots.

Pattern of repeating Carrier a 
A pattern of Wave Length is output repeatedly. 

Slot c

Frame prior to Frame b Frame next to Frame b 
 

Figure 3.1.5.1-3  Image of 1xEV-DO forward single carrier waveform pattern repetition 
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Figure 3.1.5.1-4  1xEV-DO forward active slot format after TDM 
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Idle Slot 

A waveform pattern of a single carrier for which Data Rate on the 
Carrier Edit sheet is set to “13: Idle Slot” is generated by time-division 
multiplexing the MAC Channel and Pilot Channel. 

When Data Rate is set to “13: Idle Slot”, all the slots of that single carrier 
become idle slots. 

The MAC channel to be multiplexed, values of RPC bit and RA bit, and 
channel gain can be set for each slot in a frame. 
Figure 3.1.5.1-5 shows the block diagram of a 1xEV-DO forward idle slot 
and Figure 3.1.5.1-6 shows the 1xEV-DO forward idle slot format after 
time-division multiplexing (TDM). Figure 3.1.5.1-3 shows an image of 
single carrier waveform pattern repetition. 
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Figure 3.1.5.1-5  Block diagram of 1xEV-DO forward idle slot 
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Figure 3.1.5.1-6  1xEV-DO forward idle slot format after TDM 
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3.1.5.2 Multicarrier 

A multicarrier consists of single carriers for which Carrier Select is set to 
ON in the Multicarrier Composition sheet. When only one single carrier 
is set to ON for Carrier Select, a multicarrier waveform pattern is not 
generated but a single carrier waveform pattern. A single carrier with 
smaller carrier number is located lower on an actual frequency axis, and 
a single carrier with greater carrier number is located upper. 
The frequency offset between adjacent single carriers is the value 
specified in Spacing in the Multicarrier Composition sheet. When 
outputting a multicarrier from the MG3700A/MG3710A, the center 
frequency corresponds to the frequency centered between the single 
carrier that is set to ON and has the greatest carrier number and the 
single carrier that is set to ON and has the smallest carrier number. 
Figure 3.1.5.2-1 shows multicarrier examples. 

(Example 1)  When all the single carriers are set to ON 

 

Single carrier 1

Center frequency Spacing 

Frequency

Single carrier 9  
 

(Example 2)  When the single carriers 1, 3, 4, and 6 are set to ON 

 
Spacing

Single carrier 1 

Center frequency

Frequency 

Single carrier 6  

Figure 3.1.5.2-1  Multicarrier examples 
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3.1.6 Clipping 
This software executes clipping for data that exceeds the maximum value 
during waveform pattern generation in respect to both I and Q phases. 
When clipping is executed, a dialog box is displayed to notify that 
clipping was executed. 

 

3.1.7 Sample parameter file 
Sample parameter files are saved in the folder where the 
1xEVDO_FWD.exe file is stored after installing the IQproducerTM. The 
parameters can be automatically set for generating a waveform pattern 
of the signal that conforms to the 3GPP2 test specification by reading a 
sample parameter file with the parameter file reading function available 
from the 1xEV-DO forward Carrier Edit sheet. Refer to Table 3.1.7-1 for 
details of the settings in each sample parameter file. 

Table 3.1.7-1  Settings in sample parameter files 

No. Sample Parameter File 
Data Rate

(kbps) 
Slots

Modulation 
Type 

MAC Channel 
No. of 

carriers 

0 FWD_38_4 kbps_16slot.prm 38.4 16 QPSK 

RABit = Random, 
RAChannel Gain = 
12.04 dB *, 
RPCBit = Random, 
RPC ChannelGain = 
11.42 dB (* 

Single 
carrier 

1 FWD_76_8 kbps_8slot.prm 76.8 8 QPSK 
2 FWD_153_6 kbps_4slot.prm 153.6 4 QPSK 
3 FWD_307_2 kbps_2slot.prm 307.2 2 QPSK 
4 FWD_614_4 kbps_1slot.prm 614.4 1 QPSK 
5 FWD_307_2 kbps_4slot.prm 307.2 4 QPSK 
6 FWD_614_4 kbps_2slot.prm 614.4 2 QPSK 
7 FWD_1228_8 kbps_1slot.prm 1228.8 1 QPSK 
8 FWD_921_6 kbps_2slot.prm 921.6 2 8-PSK 
9 FWD_1843_2 kbps_1slot.prm 1843.2 1 8-PSK 
10 FWD_1228_8 kbps_2slot.prm 1228.8 2 16QAM 
11 FWD_2457_6 kbps_1slot.prm 2457.6 1 16QAM 
12 FWD_Idle.prm Idle Slot   
13 FWD_2457_6 kbps_x4.prm 2457.6 1 16QAM Four 

multicarriers14 FWD_Idle_x4.prm Idle Slot   

 

*: A value relative to pilot channel 
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3.1.8 Auxiliary signal output 
Select a waveform pattern generated by the CDMA2000 1xEV-DO 
IQproducerTM on the MG3700A/MG3710A to output the marker that is 
synchronized with the RF signal as an auxiliary signal from the AUX 
Input/Output on the rear panel of the MG3700A/MG3710A. Frame 
Trigger (Connector 1), Slot Trigger (Connector 2) and Symbol Clock 
(Connector 3) are output.  

 Frame Trigger 
A 26.67-ms cycle pulse that is synchronized with the symbol at the 
beginning of the frame is output from Connector 1. Change Polarity 
for Marker 1 to change the signal polarity. 
 

 RF Gate 
Shows burst ON/OFF status of MG3700A/MG3710A RF output when 
a burst wave is used as the waveform pattern. The correspondences 
between burst status and output signal status are as follows. 
Burst ON: High level 
Burst OFF: Low level 
The correspondences shown above apply when Polarity for Marker 2 is 
set to Positive. These correspondences are reversed when Polarity is 
set to Negative. 

 

 Symbol Clock 
A 0.814-ms cycle symbol clock that is synchronized with the symbol is 
output from Connector 3. Change Polarity for Marker 3 to change the 
signal polarity. 
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3.2 Detailed Description of 1xEV-DO Reverse 

IQproducer™ Function 
3.2.1 Waveform pattern parameter setting screen 

3.2.1.1 Main screen 

On common platform screen, click the System (Cellular) tab, and then 
click 1xEVDO RVS to display the main screen.  

The main screen comes with the menu and tool buttons used to open 
function screens. When a function item is selected from the menu or a 
tool button is clicked, the corresponding function screen is displayed. The 
over sampling rate, the number of active carriers, and the pattern name 
of the waveform pattern to be generated are displayed in the main screen, 
as well as a graph showing the parameter settings. 

 

Menu

Tool buttons

Graph sheet

Waveform Information
display

 

Figure 3.2.1.1-1  1xEV-DO Reverse IQproducer main screen 
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(1) [File] menu 

 

Figure 3.2.1.1-2  Screen when File is selected 

 

 Recall Parameter File 
 Loads the parameter files saved by Save Parameter File. Setting 

can be facilitated by using the loaded parameters. 
 

 Save Parameter File 
Saves the setting parameters to a file. 
 

 Exit 
Exits this Software.  
 

(2) [Edit] menu 

 

Figure 3.2.1.1-3  Screen when Edit is selected 

 

 Waveform Pattern Edit 
Displays Waveform Pattern Edit screen. For details, refer to 3.2.1.2 
“Waveform Pattern Edit screen”. 
 

 Quick Edit 
Displays Quick Edit screen. For details, refer to 3.2.1.3 “Quick Edit 
screen”. 

 

 Calculation Waveform Pattern 
Starts waveform pattern generation after parameter setting. This is 
the same operation with clicking the Calculation button on a 
parameter setting sheet. 
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 Calculation & Load  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 

 Calculation & Play  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  

 

 

 (3) [Transfer Setting] menu 

 

Figure 3.2.1.1-4  Screen when Transfer Setting is selected 

 

Displays the Transfer & Setting Wizard screen. Every operation 
ranging from connecting the PC and MG3700A or MG3710A and 
transferring the waveform pattern to the MG3700A or MG3710A, 
to loading the waveform pattern into the MG3700A or MG3710A 
ARB memory is performed at this screen. 

 

 (4) [Simulation] menu 

 

Figure 3.2.1.1-5  Screen when Simulation is selected 
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 CCDF 
Displays the CCDF graph display screen. In this screen, the CCDF 
of the generated waveform pattern is displayed in a graph. 
 

 FFT 
Displays the FFT graph display screen. In this screen, the 
FFT-processed spectrum of the generated waveform pattern is 
displayed in a graph. 

 

 
(5) Recall Parameter File button 

[Overview] Clicking this button displays the dialog box for reading
a parameter file. 

 Refer to Section 3.2.3.2 “Reading parameter file.”

 
(6) Save Parameter File button 

[Overview] Clicking this button displays the dialog box for saving 
a parameter file. 

 Refer to Section 3.2.3.1 “Saving parameter file.”

 
(7) Waveform Pattern Edit button 

[Overview] Clicking this button displays the Waveform Pattern
Edit screen for setting each carrier. 

 
(8) Quick Edit button 

[Overview] Clicking this button displays the Quick Edit screen for
setting each carrier. 

 
(9) Calculate Waveform Pattern button 

[Overview] Clicking button starts waveform pattern generation 
based on the parameter settings. 

 
 

 
(10) Calculation & Load button 

[Overview] After waveform generation is finished, the created
waveform pattern is loaded into the MG3710A
waveform memory.  

 
 

 
(11） Calculation & Play button 

[Overview] After waveform generation is finished, the created
waveform pattern is loaded and selected at the
MG3710A waveform memory.  

 
(12) Transfer & Setting Wizard button 

[Overview] Clicking this button opens the waveform pattern 
transfer wizard “Transfer & Setting Wizard.” 
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(13) CCDF Simulation button 

[Overview] Clicking this button displays the trace of the
last-generated waveform pattern on the CCDF Graph 
Monitor screen. 
When the CCDF Graph Monitor screen is not
displayed before this button is clicked, clicking this
button opens the CCDF Graph Monitor screen first
and then displays the trace. 

 
(14) FFT Simulation button 

[Overview] Clicking this button displays the trace of the 
last-generated waveform pattern on the FFT Graph 
Monitor screen. 
When the FFT Graph Monitor screen is not displayed
before this button is clicked, clicking this button opens
the FFT Graph Monitor screen first and then displays 
the trace. 

 
(15) Exit button 

[Overview] Clicking this button exits the 1xEV-DO Reverse 
IQproducerTM. 

 
(16) Waveform Information display field 

[Overview] The over sampling rate (Over Sampling), the number 
of active carriers (Active Carrier Number), and the 
pattern name of the waveform pattern (Pattern Name) 
to be generated are displayed. Active Carrier Number 
shows the total number of carriers that are set to ON. 
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(17) Power graph 

 

Figure 3.2.1.1-6  Power graph 

 

[Overview] The powers of the carriers that are set to ON are 
displayed. The gains are displayed on the vertical axis 
in dB units based on the total power of all the carriers 
that are set to ON. The powers of the carriers that are 
set to OFF are not displayed. 
 

(18) Freq. Offset graph 

 

Figure 3.2.1.1-7  Freq. Offset graph 

 

[Overview] The frequency offsets of the carriers that are set to ON 
are displayed. The frequency offsets of the carriers 
that are set to OFF are not displayed. 
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(19) Delay graph 

 

Figure 3.2.1.1-8  Delay graph 

 

[Overview] The delays of the carriers that are set to ON are 
displayed in green. 
In this case, “delay” is the output timing delay of the 
frame head of the carrier from a frame trigger output 
from the rear panel of the MG3700A/MG3710A. 
 

(20) Phase Offset graph 

 

Figure 3.2.1.1-9  Phase Offset graph 

 

[Overview] The phase offsets of the carriers that are set to ON are 
displayed in orange. 
In this case, “phase offset” is a phase displacement 
relative to other carriers. 
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3.2.1.2 Waveform Pattern Edit screen 

When [Waveform Pattern Edit] is selected from the [Edit] menu or the 
 tool button is clicked on the main screen, the Waveform Pattern 

Edit screen is displayed. The modulation parameters for each carrier can 
be set in this screen. The carrier number of the displayed carrier is 
displayed on the left of the screen, and all the carriers can be viewed by 
moving the scroll bar on the right of the screen for setting their 
parameters. 

 

Figure 3.2.1.2-1  Waveform Parameter Edit screen 

 

(1) Over Sampling 

[Overview] The over sampling rate can be set. Over sampling 
rate is the ratio of the sampling rate and chip rate 
of the waveform pattern. 

[Initial value] 16 

[Setting range] 4, 8, 16 
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(2) Pattern Name 

[Overview] The waveform pattern file name can be set. 
A waveform pattern generated by selecting 
[Calculate Waveform Pattern] from the [Edit] menu 
or by clicking the   tool button consists of two 
waveform pattern files: waveform pattern 
information file and waveform pattern data file. 
The waveform pattern file name consists of the 
character string set here and the extension “.wvi” 
(for waveform pattern information file) or “.wvd” 
(for waveform pattern data file). 

[Initial value] None 

[Setting range] Within 20 characters 
Alphanumeric characters and the following symbols 
can be used for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
 

(3) Carrier On/Off checkbox 

[Overview] Used to set each carrier On (checked) or Off (left 
blank). 

[Initial value] Off 

[Setting range] On, Off 
 

(4) Long Code Mask 

[Overview] The I and Q long code masks can be set. MQ is 
automatically set when MI is set. It is also possible 
to MQ manually. 

[Initial value] MI = 0x3FF00000000, MQ = 0x3FE00000001 

[Setting range] 0x0 to 0x3FFFFFFFFFF (for both MI and MQ) 
 

(5) Power 

[Overview] The power of the carrier can be set. 
The power difference between the carriers becomes 
close to this value. This value is a relative value, 
not an absolute one. 
This value may not match the value on the Power 
graph in the main screen, since the power on the 
vertical axis of the Power graph is based on the 
total of all the carriers. 

[Initial value] 0.000 dB 

[Setting range] 80.000 to 0.000 dB 
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(6) Frequency Offset 

[Overview] The frequency offset of the carrier can be set. 
In this case, “frequency offset” is an offset of the 
carrier frequency from the center frequency set in 
the MG3700A/MG3710A. 

[Initial value] 0.000 MHz 

[Setting range] 5.000 to 5.000 MHz 
 

(7) Delay 

[Overview] The delay of the carrier can be set. 
In this case, “delay” is the output timing delay of 
the frame head of the carrier from a frame trigger 
output from the rear panel of the 
MG3700A/MG3710A. 

[Initial value] 0/16 chips 

[Setting range] 0/16 chips to 524287/16 chips 
 

(8) Phase Offset 

[Overview] The phase offset of the carrier can be set. 
In this case, “phase offset” is a phase displacement 
relative to other carriers. 

[Initial value] 0.000 rad. 

[Setting range] 0.000 to 2.000 rad. 
 

(9) DRC CH On/Off check box 

[Overview] Used to set the DRC channel On (checked) or Off 
(left blank). 

[Initial value] Off 

[Setting range] On, Off 
 

(10) DRC CH Gain 

[Overview] The DRC channel gain can be set. This is a value 
relative to the pilot channel. 

[Initial value] 0.000 dB 

[Setting range] 80.000 to 20.000 dB 
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(11) DRC Symbol 

[Overview] The DRC channel symbol data can be set in 
hexadecimal. The leftmost value indicates the DRC 
channel symbol data of the first slot, and each digit 
corresponds to the DRC channel symbol data of 
each slot sequentially. 
When a value less than 16 digits is set, “0”s are 
added to complement the data. 

[Initial value] 0000000000000000 (HEX) 

[Setting range] 0000000000000000 to FFFFFFFFFFFFFFFF (HEX) 
 

(12) DRC Cover Symbol 

[Overview] The DRC cover symbol data can be set in octal. The 
leftmost value indicates the DRC cover symbol data 
of the first slot, and each digit corresponds to the 
DRC cover symbol data of each slot sequentially. 
When a value less than 16 digits is set, “0”s are 
added to complement the data. 

[Initial value] 0000000000000000 (OCT) 

[Setting range] 0000000000000000 to 7777777777777777 (OCT) 
 

(13) ACK CH On/Off check box 

[Overview] Used to set the ACK channel On (checked) or Off 
(left blank). 

[Initial value] Off 

[Setting range] On, Off 
 

(14) ACK CH Gain 

[Overview] The ACK channel gain can be set. This is a value 
relative to the pilot channel. 

[Initial value] 0.000 dB 

[Setting range] 80.000 to 20.000 dB 
 



 

Chapter 3  Detailed Description of Functions 

3-40 

(15) ACK CH bit 

[Overview] The ACK channel bit can be set. The leftmost value 
indicates the ACK channel bit of the first slot, and 
each digit corresponds to the ACK channel bit of 
each slot sequentially. 
‘1 (ACK)’ is transmitted in the slot for which A is set. 
‘0 (NACK)’ is transmitted in the slot for which N is 
set. The slot for which X is set is DTX. 
When a value less than 16 digits is set, “X”s are 
added to complement the data. 

[Initial value] AAAAAAAAAAAAAAAA 

[Setting range] A (ACK), N (NACK), X (DTX) 
 

(16) Data CH On/Off check box 

[Overview] Used to set the Data channel On (checked) or Off 
(left blank). 

[Initial value] Off 

[Setting range] On, Off 
 

(17) Data CH Gain 

[Overview] The Data channel gain can be set. This is a value 
relative to the pilot channel. 

[Initial value] 0.000 dB 

[Setting range] 80.000 to 20.000 dB 
 

(18) Data Rate 

[Overview] The Data channel data rate can be set. 

[Initial value] 9.6 kbps 

[Setting range] 9.6, 19.2, 38.4, 76.8, 153.6 kbps 
 

(19) Data 

[Overview] The payload data of the Data channel can be set. 
PN9fix indicates a non-continuous PN9 coding 
sequence. 

[Initial value] PN9fix 

[Setting range] PN9fix, All ‘0’, All ‘1’ 
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(20) Initial LFSR 

[Overview] The initial value of the shift register for PN9 
generation can be set in hexadecimal when PN9fix 
is set for Data. 

[Initial value] 1FF 

[Setting range] 0 to 1FF (HEX) 
 

(21) RRI Symbol Rate 

[Overview] The RRI symbol can be set in binary.  
When Data Rate is set, the RRI symbol is 
automatically set to the value corresponding to 
Data Rate. It is also possible to set the RRI symbol 
manually. 

[Initial value] 001 

[Setting range] 000 to 101 (BIN) 
 

(22) [OK] button 

[Overview] Clicking this button closes the Waveform Pattern 
Edit screen, saving the current settings in the 
screen. 

(23) [Cancel] button 

[Overview] Clicking this button closes the Waveform Pattern 
Edit screen, without saving the current settings in 
the screen. 
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3.2.1.3 Quick Edit screen 

When [Quick Edit] is selected from the [Edit] menu or the  tool 
button is clicked on the main screen, the Quick Edit screen is displayed. 
There are two sheets on the Quick Edit screen: Uniformly Edit sheet and 
Random Edit sheet. On the Uniformly Edit sheet, parameters of two or 
more specified carriers can be set at the same time. On the Random Edit 
sheet, parameters of two or more specified carriers can be set to random 
values at the same time. 

(1) [OK] button 

[Overview] Clicking this button closes the Quick Edit screen, saving 
the current settings in the screen. 

(2) [Cancel] button 

[Overview] Clicking this button closes the Quick Edit screen, 
without saving the current settings in the screen. 
 

Uniformly Edit sheet 

In the Uniformly Edit sheet, settings can be carried out collectively for 
the carriers specified in Edit Range. When carrying out collective 
settings in the Uniformly Edit sheet, select the parameters to be set by 
checking their checkbox (on the left) in the Parameter Selection field, 
specify the target carriers in the Edit Range field, and then click the 
[Apply] button. The setting method, initial value, and setting range of 
each control (parameter) in the Parameter Selection field are the same 
with those in the Waveform Pattern Edit screen. 

 

Figure 3.2.1.3-1  Uniformly Edit sheet 
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(1) Edit Range 

[Overview] The target range of carriers for Uniformly Edit can be 
specified. 
When the [All] radio button is checked and the [Apply] 
button is clicked, the settings are applied to all the 
carriers. 
When the [Carrier Selection] radio button is checked 
and the [Apply] button is clicked, the settings are 
applied to the carriers that meet the conditions specified 
in the edition box on the right of the [Carrier Selection] 
radio button. The target carriers can be specified in the 
edition box by the following method: 

1. Specify the carriers by entering their carrier number. 
2. Two or more successive carriers can be specified by 

using a hyphen (-) as follows: 
(First carrier number of successive carrier 
numbers)+‘-’+(Last carrier number of successive 
carrier numbers) 

3. Several specification items described in 1. and 2. 
above can be entered by delimiting with a comma (,). 

Example: 1-5,10,13,64 

(2) Apply button 

[Overview] Clicking this button applies the settings of the 
parameters for which the checkbox is checked in the 
Parameter Selection field to the carriers specified in the 
Edit Range field. 
 

Random Edit sheet 

In the Random Edit sheet, settings can be carried out collectively for the 
carriers specified in Edit Range. When carrying out collective settings in 
the Random Edit sheet, select the parameters to be set to a random value 
by checking their checkbox (on the left) in the Parameter Selection field, 
specify the target carriers in the Edit Range field, and then click the 
[Apply] button. 
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Figure 3.2.1.3-2  Random Edit sheet 

 

(1) Edit Range 

[Overview] The target range of carriers for Random Edit can be 
specified. 
When the [All] radio button is checked and the [Apply] 
button is clicked, the settings are applied to all the 
carriers. 
When the [Carrier Selection] radio button is checked 
and the [Apply] button is clicked, the settings are 
applied to the carriers that meet the conditions specified 
in the edition box on the right of the [Carrier Selection] 
radio button. The target carriers can be specified in the 
edition box by the following method: 

1. Specify the carriers by entering their carrier number. 
2. Two or more successive carriers can be specified by 

using a hyphen (-) as follows: 
(First carrier number of successive carrier 
numbers)+‘-’+(Last carrier number of successive 
carrier numbers) 

3. Several specification items described in 1. and 2. 
above can be entered by delimiting with a comma (,). 

Example: 1-5,10,13,64 

(2) Apply button 

[Overview] Clicking this button applies the settings of the 
parameters for which the checkbox is checked in the 
Parameter Selection field to the carriers specified in the 
Edit Range field. 
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3.2.1.4 Execution and Result screen 

When [Calculate Waveform Pattern] is selected from the [Edit] menu or 
the   tool button is clicked on the main screen, waveform pattern 
calculation is started and the Execution and Result screen is displayed. 
This screen displays the waveform pattern calculation status with 
character strings and the progress bar. A button is provided on the lower 
of the Execution and Result screen. This button is the [Cancel] button 
during calculation, used to interrupt the calculation. And this button is 
the [OK] button after the calculation is completed, used to close the 
Execution and Result screen. 

 

Figure 3.2.1.4-1  Execution and Result screen 
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3.2.1.5 Calculation & Load 

Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.2.1.5-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.2.1.5-2  Select Memory Screen 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  
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3.2.1.6 Calculation & Play 

Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.2.1.6-1  Select SG Screen 
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3.2.2 Waveform pattern generation procedure 
This section provides a general procedure for generating a 1xEV-DO 
Reverse type waveform pattern using this software. 

<Procedure> 

1. Start up this software. The main screen is displayed. 

2. Set the parameters by reading a parameter file and editing 
parameters in the Waveform Pattern Edit screen and/or Quick Edit 
screen. 

3. After setting the parameters, select [Calculate Waveform Pattern] 
from the [Edit] menu or click the   tool button on the main 
screen. The waveform pattern generation is started. 

4. The calculation is completed when “Complete” is displayed on the 
Execute and Result screen. Click the [OK] button to close the 
Execution and Result screen. 

5. If necessary, transfer the generated waveform pattern to the 
MG3700A/MG3710A or analyze the generated waveform pattern in 
the CCDF/FFT Graph Monitor screen. 
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3.2.3 Saving/reading parameters 
With this software, all the set parameters can be saved in a parameter 
file (extension: .prm), and the settings at the time when saving the 
parameter file can be restored anytime as required by reading this 
parameter file. 

3.2.3.1 Saving parameter file 

When running on PC 

1. Click the [Save Parameter File] button in [File] menu or click the 

  button to display the parameter file saving screen.  

 

Figure 3.2.3.1-1  Parameter file saving screen 

 

2. Enter a file name in the [File name] text box and click the [Save] 
button to save the parameter file. 
When the save destination is not changed in the [Save in] box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\1xEVDO_REV\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
 

When running on MG3710A 

1. Click the [Save Parameter File] button in [File] menu or click the 

  button to display the parameter file saving screen.  
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Figure 3.2.3.1-2  Parameter File Saving Screen (MG3710A) 

 

2. Select the folder to store the file in the [Directories] field, and then 
enter the name of the file using the [File Name] box. Click [OK] to 
save the parameter file.  
To initialize the setting in the [Directories] field, click the [Default 

Root] button. 

 

3.2.3.2 Reading parameter file 

When running on PC 

1. Select [Recall Parameter File] from the [File] menu or click the 
 tool button to display the parameter file reading screen. 

 

Figure 3.2.3.2-1  Parameter file reading screen 
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2. Select a parameter file to be read from the file list, and then click 
the [Open] button to read the selected parameter file. 
 

When running on MG3710A 

1. Select [Recall Parameter File] from the [File] menu or click the 
 tool button to display the parameter file reading screen.  

 

Figure 3.2.3.2-2  Parameter File Reading Screen (MG3710A) 

 

2. Select the directory where the files to be loaded is stored in the 
[Directories] field. Click the desired file from the [File List], and 
click OK. To initialize the setting in the [Directories] field, click the 
[Default Root] button. 
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3.2.4 Displaying graph 
The generated waveform pattern can be displayed in a CCDF or FFT 
graph by using this software. 

Displaying CCDF graph 

1. Generate a waveform pattern by executing “Calculate Waveform 
Pattern” (waveform pattern calculation). 

2. Select [CCDF] from the [Simulation] menu or click the  tool 
button. The CCDF Graph Monitor screen shown in Figure 3.2.4-1 is 
displayed with the trace of the generated waveform pattern. 

 

Figure 3.2.4-1  CCDF Graph Monitor screen 

 

When a waveform pattern is generated by changing parameters and 
executing “Calculate Waveform Pattern” while other traces are displayed 
in the CCDF Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two methods: 

 Displaying the new trace in the same screen with the previous traces 

 Deleting the previous traces to display the new trace 
 

Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When displaying a CCDF graph while an FFT graph is 
displayed, execute the CCDF graph generation after FFT graph 
generation is completed. 
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 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF Graph 
Monitor screen. 

2. Select [CCDF] from the [Simulation] menu or click the  tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the CCDF Graph Monitor screen. 
Up to eight traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF 
Graph Monitor screen. 

2. Select [CCDF] from the [Simulation] menu or click the  tool 
button. The confirmation message shown in Figure 3.2.4-2 below 
appears: 

 

Figure 3.2.4-2  Confirmation message 

 

 Click the [Yes] button. The previous traces are deleted from the 
CCDF Graph Monitor screen, and the trace of the waveform pattern 
newly generated is displayed. 
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Displaying FFT graph 

1. Generate a waveform pattern by executing “Calculate Waveform 
Pattern” (waveform pattern calculation). 

2. Select [FFT] from the [Simulation] menu or click the  tool 
button. The FFT Graph Monitor screen shown in Figure 3.2.4-3 is 
displayed with the trace of the generated waveform pattern. 

 

Figure 3.2.4-3  FFT Graph Monitor screen 

 

When a waveform pattern is generated by changing parameters and 
executing “Calculate Waveform Pattern” while other traces are displayed 
in the FFT Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two methods: 

 Displaying the new trace in the same screen with the previous traces 

 Deleting the previous traces to display the new trace 
 

Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When displaying an FFT graph while a CCDF graph is 
displayed, execute the FFT graph generation after CCDF graph 
generation is completed. 
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 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Select [FFT] from the [Simulation] menu or click the  tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the FFT Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Select [FFT] from the [Simulation] menu or click the  tool 
button. The confirmation message shown in Figure 3.2.4-4 below 
appears: 

 

Figure 3.2.4-4  Confirmation message 

 

 Click the [Yes] button. The previous traces are deleted from the FFT 
Graph Monitor screen, and the trace of the waveform pattern newly 
generated is displayed. 
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3.2.5 Detailed description of modulation parameter 

3.2.5.1 Modulation parameter for each carrier 

1xEV-DO Reverse type waveforms that conform to 3GPP2 C.S0024 can 
be generated by using this application. Waveform pattern generation is 
carried out based on the modulation type specified in 3GPP2 C.S0024. 
The value set in [Data] (hereafter, a character string enclosed by 
brackets [ ] indicates a control of the 1xEV-DO Reverse IQproducerTM) of 
the Waveform Pattern Edit screen or the Quick Edit screen is mapped to 
the payload data field as shown in Figure 3.2.5.1-1. The CRC bit and tail 
bit are mapped to the FCS and TAIL fields in a packet, respectively. This 
packet is mapped to Data Channel MAC Layer Packet shown in the block 
diagram of Figure 3.2.5.1-2. In this block diagram, the Pilot Channel 
data is set to all ‘0’, RRI symbol is set to the value in [RRI Symbol], the 
ACK Channel data is set to the value in [ACK CH Bit], the DRC Symbols 
data is set to the value in [DRC Symbol], and the Walsh Cover Symbol 
data is set to the value in [DRC Cover Symbol]. Note that the DRC 
channel is output behind the Data and ACK channel by half slots (= 
0.833 ms). Only the channels for which [On/Off check box for each 
channel] is set to ON (checked) are multiplexed. 

FCS
16

Bits

TAIL
6

Bits

Payload Data
234, 490, 1002, 2026, or 4074

Bits

256, 512, 1024, 2048, or 4096 Bits

 

Figure 3.2.5.1-1  Reverse packet format 
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Figure 3.2.5.1-2  Block diagram of 1xEV-DO Reverse 

 

3.2.5.2 Multicarrier 

Al the carriers that are set to On in the Waveform Pattern Edit and/or 
Quick Edit screen are targeted to be multiplexed to generate a 
multicarrier. A multicarrier is generated so as to meet the following 
conditions: 

 The gain difference from that of another carrier is equal to the value 
set in [Power]. 

 The frequency offset from the center frequency of the 
MG3700A/MG3710A is equal to the value set in [Frequency Offset]. 

 During RF output, the frame head is output behind a frame trigger 
output from the rear panel of the MG3700A/MG3710A by the delay 
time set in [Delay]. 

 The phase offset from that of another carrier is equal to the value set 
in [Phase Offset]. 
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3.2.6 Clipping 
This software executes clipping for data that exceeds the maximum value 
during waveform pattern generation in respect to both I and Q phases. 
When clipping is executed, a dialog box is displayed to notify that 
clipping was executed. 

3.2.7 Sample parameter file 
Sample parameter files are saved in the folder where the 
1xEVDO_RVS.exe file is stored after installing the IQproducerTM. The 
parameters can be automatically set for generating a waveform pattern 
of the signal that conforms to the 3GPP2 test specification by reading a 
sample parameter file with the parameter file reading function available 
from the 1xEV-DO Reverse main screen. Refer to Tables 3.2.7-1 and 
3.2.7-2 for details of the settings in each sample parameter file. 

Table 3.2.7-1  Settings in sample parameter files (1) 

No. Sample Parameter File 
Data 
Rate 

(kbps)

RRI 
Symbol

DRC 
Value 

DRC 
Cover 

ACK  
ChannelBit 

Long Code 
Mask 

0 RVS_9_6 kbps_TX.prm 9.6 001 0x01 W08 0 

MI = 
0x3FF00000000
MQ = 
0x3FE00000001

1 RVS_19_2 kbps_TX.prm 19.2 010 0x01 W08 0 
2 RVS_38_4 kbps_TX.prm 38.4 011 0x01 W08 0 
3 RVS_76_8 kbps_TX.prm 76.8 100 0x01 W08 0 
4 RVS_153_6 kbps_TX.prm 153.6 101 0x01 W08 0 
5 RVS_9_6 kbps_RX.prm 9.6 001 0x01 W08 0 
6 RVS_19_2 kbps_RX.prm 19.2 010 0x01 W08 0 
7 RVS_38_4 kbps_RX.prm 38.4 011 0x01 W08 0 
8 RVS_76_8 kbps_RX.prm 76.8 100 0x01 W08 0 
9 RVS_153_6 kbps_RX.prm 153.6 101 0x01 W08 0 
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Table 3.2.7-2  Settings in sample parameter files (2) 

No. Sample Parameter File 
Data Rate 

(kbps) 
Data/Pilot RRI/Pilot DRC/Pilot ACK/Pilot 

0 RVS_9_6 kbps_TX.prm 9.6 3.75 dB 0 dB 3.0 dB 3.0 dB 
1 RVS_19_2 kbps_TX.prm 19.2 6.75 dB 0 dB 3.0 dB 3.0 dB 
2 RVS_38_4 kbps_TX.prm 38.4 9.75 dB 0 dB 3.0 dB 3.0 dB 
3 RVS_76_8 kbps_TX.prm 76.8 13.25 dB 0 dB 3.0 dB 3.0 dB 
4 RVS_153_6 kbps_TX.prm 153.6 18.50 dB 0 dB 3.0 dB 3.0 dB 
5 RVS_9_6 kbps_RX.prm 9.6 3.75 dB 0 dB 3.0 dB 0 dB 
6 RVS_19_2 kbps_RX.prm 19.2 6.75 dB 0 dB 3.0 dB 0 dB 
7 RVS_38_4 kbps_RX.prm 38.4 9.75 dB 0 dB 3.0 dB 0 dB 
8 RVS_76_8 kbps_RX.prm 76.8 13.25 dB 0 dB 3.0 dB 0 dB 
9 RVS_153_6 kbps_RX.prm 153.6 18.50 dB 0 dB 3.0 dB 0 dB 

 

3.2.8 Auxiliary signal output 
Select a waveform pattern generated by the CDMA2000 1xEV-DO 
IQproducerTM on the MG3700A/MG3710A to output the marker that is 
synchronized with the RF signal as an auxiliary signal from the AUX 
Input/Output on the rear panel of the MG3700A/MG3710A. Frame 
Trigger (Connector 1), Slot Trigger (Connector 2) and Symbol Clock 
(Connector 3) are output.  

 Frame Trigger 
A 26.67-ms cycle pulse that is synchronized with the symbol at the 
beginning of the frame is output from Connector 1. Change Polarity 
for Marker 1 to change the signal polarity.  
 

 RF Gate 
Shows burst ON/OFF status of MG3700A/MG3710A RF output when 
a burst wave is used as the waveform pattern. The correspondences 
between burst status and output signal status are as follows. 
Burst ON: High level 
Burst OFF: Low level 
The correspondences shown above apply when Polarity for Marker 2 is 
set to Positive. These correspondences are reversed when Polarity is 
set to Negative. 
 

 Symbol Clock 
A 0.814-s cycle symbol clock that is synchronized with the symbol is 
output from Connector 3. Change Polarity for Marker 3 to change the 
signal polarity. 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A or MG3710A .......................................... 4-2 
4.1.1 Transferring waveform pattern to internal  

hard disk ........................................................... 4-2 
4.1.2 Loading to Waveform Memory ......................... 4-4 
4.1.3 Selecting Waveform Pattern ............................. 4-5 
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4.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual IQproducer™.  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the “MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe)”.  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways. 

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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A list of error messages is shown below. In an error message, n1 and n2 
indicate a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 
Can not open file The file cannot be opened. 
Can not open file (“s”) The file s cannot be opened. 
Can not read file Reading from the file is disabled. 
Can not write file Writing to the file is disabled. 
Directory not found (“s”) The folder s cannot be found. 
Disk full (“s”) The disk capacity becomes full while creating the 

file s. 
Division by zero: 0 division was executed. 
Division by zero: NO RPC CH turned ON Normalization was performed when all RPC Ch 

are OFF. 
File not found. (“s”) The file s cannot be found. 
Invalid file format (“s”) The format of the file s is invalid. 
Invalid Frame Length. Composition Execute was performed when Frame 

Length is not set to 3. 
Out of range: s (n1 − n2) The value of the parameter s is out of the setting 

range from n1 to n2. 
The Waveform data file is not generated. The waveform pattern data file is not generated. 
Not enough memory. The memory capacity is insufficient. 

 
A list of warning messages is shown below.   

Table A-2  Warning messages 

Warning Message Description 
A Transfer wizard is already running. The Transfer & Setting Wizard has already been 

activated. 
Carrier Calculation has not yet been executed. Composition Execute was performed when Carri-

er Calculate has not been executed. 
In Making Multicarrier, please set a value of 
Wave Data Length to 3 

It was tried to make multicarrier from a single 
carrier waveform data when Frame Length is not 
set to 3. 
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Initial values for 1xEV-DO Forward 

<Carrier Edit> 
Wave Data Length 3 frames 
Over Sampling 16 
Data Rate 12: 2457.6kbps (1slot)16QAM 
TCH Data PN15 
Offset Index 0 
TCH 1 5  
TCH 2 6 
TCH 3 7  
TCH 4 8 
Reg 1 7FFF 
Reg 2 387F 
Reg 3 3F80 
Reg 4 3C07 
 
<RPC/RA Parameter Edit> 
Frame 1 
Slot 1 
RA Bit 0 
RPC Bit 0 
CH Power 0 dB 
MAC Index 4 Off 
MAC Indexes 5 to 63 Off 
 
<Multicarrier Composition> 
Spacing 1.23MHz 
Carrier 1 to Carrier 8 On 
Carrier 9 Off 
Pattern Name Edit_Data 
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Initial values for 1xEV-DO Reverse 

<Waveform Pattern Edit> 
Carrier 1 to Carrier 64 Off 

The following are applied to all carriers. 
Long Code Mask MI 0x3FF00000000 
Long Code Mask MQ 0x3FE00000001 
Power 0.000 dB 
Frequency Offset 0.000 MHz 
Delay 0.000 µs  
Phase Offset 0.000 πrad. 
DRC CH Off  
DRC CH Gain 0.000 dB 
DRC Symbol 0000000000000000 
DRC Cover Symbol 0000000000000000 
ACK CH Off 
ACK CH Bit AAAAAAAAAAAAAAAA  
ACK CH Gain 0.000 dB 
DataCH Off 
DataCH Gain 0.000 dB 
Data Rate 9.6 kbps  
Data PN9fix 
Initial LFSR 1FF 
RRI Symbol 9.6 kbps  
Data 001 
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